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Product SAEAUT SCADA™  is part of the SAEAUT SCADA
that consists of:

- SCADA server - for communication and data processing,
- SCADA clients - for visualisation and control,
- configuration application - for configuring of SAEAUT
SCADA. functionality. debugging, desktop client

Interoperability
for your devices

and software applications.
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1 Product overview

SAEAUT SCADA™  consists of:

· SCADA server - for communication and data processing
· SAEAUT SCADA Web Client- for visualisation and control

· Configuration application - for configuring of SAEAUT SCADA functionality. debugging, desktop
client

As the SCADA Server, the runtime of the application OpcDbGateway is used. Configuring of SAEAUT
SCADA is done by the configurator of the OpcDbGateway.   Details please see in the
documentation of the product OpcDbGateway. SAEAUT SCADA Web Client  is desribed in this
document.

SAEAUT SCADA™  - MAIN FEATURES:
· communication with various devices, applications, databases through:

· OPC and DDE servers
· with exploitation of DLL, ActiveX
· through database drivers

· data processing
· configurable (rich functionality without programming)
· programmable (with enhancing DLL's)

· logging in files and databases
· alarm systems:

· according to OPC AE standard
· proprietary - with alarms history

· alarm client applications:
· desktop - in configuration application
· Web client

· reports:
· configured (report is defined using configuration application)
· interactive (request to create report is defined in client application)
· using MS Excel

· historical trends - created easily by software wizard.
· SMS and E-mail can be used for logging, alarms and for application control
· visualization using:

· SAEAUT SCADA Web Client™ enabling:
· structured view of the actual data in directory tree structure
· view of tabular data from process databases using SQL commands either automatically

generated or user-defined in the Web client
· creating of interactive reports - it can export data from a database table view in the client

application using formats csv, xls, pdf and doc.
· log files viewer. Log files can contain messages about functionality of the SCADA server itself

with defined level of details as well as parameterized user messages, in which the parameters
are replaced at runtime by the current values of selected variables

· Secure access to current data and data in process databases
· connection to MS Excel over DDE (or OPC DA)
· user's HMI over OPC DA

· security is provided by two level authentication

31
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· configuring of big amounts of data points from external devices applications and data sources can
be done fast and easily using software wizards built in the configurator.

Related links on the web
OpcDbGateway on the web
OpcDbGateway blog

,

1.1 Basic functionality

SAEAUT SCADA™
· communicates with external devices, process databases, and software applications,
· prvides processing of data from above mentioned external entities,
· enables read/write data  using web client application,
according to the configuration created by SCADA Configurator.

Figure 1. Data flows in SAEAUT SCADA™

SCADA Configurator enables to create configuration data (2) and to save them to the configuration
database. SCADA SERVER reads configuration data (3) from configuration database and provides
interconnecting of data sources – process databases, devices and software applications and also
processing of data accordingly.  SCADA Server offers processed (1) live data to SAEAUT SCADA
Web Client.  It provides also (5) logging of system data (enabling control and watch functionality of the
SCADA server) as well as user messages to log files.

http://www.saeautom.sk/products/opcdbgateway.htm
http://opcdbgateway.wordpress.com/
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SAEAUT SCADA Web Client enables read / write of  (1) live data from SCADA server (using OPC DA
interface). It enables also reading of data from configuration database to find out connection strings to
process databases and path to the log files. These information uses for displaying of related data. To
display data from databases (6),(7), it uses direct access to process databases (not intermediated
by SCADA Server).

SCADA Server provides evaluation of alarm sources and saving actual status of them to the alarms
status table in one of process databases. It provides also saving of alarm states history to the alarm
history table.  SAEAUT SCADA Web Client enables to watch alarm status table and alarm history table
directly in process database. It enables also to acknowledge and to comment activated alarm source.

In terms of direct access of the  SAEAUT SCADA Web Client to process databases, it is supposed to
be used read only. Writing to process databases is possible over SCADA server to that database
tables  are mapped.

SCADA Server provides easy data persistency (4). When stopped, internal status (memory operands)
are saved to the configuration database. In case that none changes in configuration has been done the
saved internal status is used by restart of the SCADA Server.

Details to the functionality please see in documentation of the product OpcDbGateway.

2 System Requirements

· Computer/Processor: Pentium II -compatible CPU  
· Memory: at least 1 GB (recommended 4 GB)  
· OS x86 or x64: MS Windows Vista, Windows 7, Windows 8,   Windows Server 2003, 2008 R2,

2012
· Disk space:  20 MB for SCADA Web Client installation
· IIS must be installed to enable SCADA Web Client installation
· Disk space:  40 MB for SCADA Server installation
· Microsoft .NET Framework 4.0

3 Installation

The SAEAUT SCADA™  is installed  on a computer / server by administrator of the computer or
Windows domain.

· The installation can be:Compact  – SCADA Server and SCADA Web Client  are  on the same
computer

· Distributed  -  SCADA Server and SCADA Web Client  are   on different computers

The term compact installation has nothing to do with placement of communication drivers (OPC
servers ), databases and external  applications. They can be placed  locally (on the same computer
where SCADA server resides) or remotely – on other computers in the same Windows domain.

6
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3.1 Compact

1. Lunch the installation application - the installation of SCADA  (OpcDbGateway) Server and
Configurator will be started

2. Confirm license agreement
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3. Start installation by click on Install

4. Chose placement of SCADA Server - e.g. C:\Program Files\SAEAUT SCADA
5. Chose placement in START Menu - e.g. SAEAUT SCADA

6. Chose if  SCADA Server has to run as Windows service and if the DDE client has to be installed as
well.
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7. Continue with SCADA Web Client Setup
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8. After that following view will be displayed. Continue by click Exit (There can be also more items
in the dialog box, however you can click EXIT).

9. After that, web client application files will be copied to virtual directory SAEAUT-SCADA on MS IIS

10.In case that you let checked the option  „Launch Browser with SAEAUT SCADA" by completing the
installation the SAEAUT SCADA will be started.
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11. Following view will be shown in browser. You can proceed with user registering  or

distributed deployment  (if you need it).

3.2 Distributed

Distributed installation can be done using the same installation package on two different computers in
the same Windows domain.  But, on one computer only the SCADA Server and on the second only the
SCADA Web Client will be used in runtime.

On the computer where SCADA Web Client has to be used, it is necessary to activate web client user

access licenses. It will be done as described in Web client licenses activation  .  After that, SCADA

32
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server and configurator can be removed from the computer used for the SCADA Web Client.

Web client application variables have to be set such way to point to computer with running server. It
can be done using IIS manager in Application settings for SAEAUT-SCADA virtual directory using
following key - value pairs:

key="ConfigurationPath" value=""
key="AppRegistryPath" value="HKEY_LOCAL_MACHINE\SOFTWARE\SAE - Automation,
s.r.o.\OpcDbGateway\Configuration"
key="opc_server_address" value="opcda://localhost/SAEAutomation.OpcDbGatewayDA"

In case that the key "ConfigurationPath" is empty the path for configuration should be found in
registry under  "HKEY_LOCAL_MACHINE\SOFTWARE\SAE - Automation,
s.r.o.\OpcDbGateway\Configuration"

The name of the host where SCADA Server - OPC server is installed  has to be changed accordingly.
E. g.  value "opcda://localhost/SAEAutomation.OpcDbGatewayDA" has to be changed to
"opcda://s1/SAEAutomation.OpcDbGatewayDA" if s1 is the name of the host.

On both client and server has to be used the same configuration!

If it does not connect to the remote OPC DA Server correctly, make sure that you set the right DCOM
settings for the OPC Server using DCOMCNFG.EXE
If it does not help, change the authentication type using Inetmgr.exe -> SAEAUT-SCADA ->
Autenhentication -> Turn off Windows authentication, Turn on basic authentication.

You can use OPC XML DA interface instead of OPC DA interface. It does not require such strict
authentication rights. To do it, you can use OPC XML DA wrapper delivered with OpcDbGateway.
Please ask SAE - Automation, s.r.o., (Ltd.). OPC server address has to be set following way then:
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key="opc_server_address" value="http://PC-Name/XML-
DA/SAEAutomation.OpcDbGatewayDA.3.asmx."

3.3 Web client licenses activation

To be able to access to the SCADA Server over Internet/intranet using a web browser you need to be
registered for web access and logged in. By default, one web access license is activated after
installation and can be used for registration.

To obtain additional web client access licenses, please ask vendor SAE - Automation, s.r.o., (Ltd.) to
send link on installation with required nr. of licenses.

Additional client access licenses are activated only if the whole SAEAUT SCADA is activated. In
demo mode, only one client has access.

Installation of the additional web client access licenses is provided by SCADA Server (OpcDbGateway)
runtime. After installing of SAEAUT SCADA, only one user – administrator  has activated access and
can register.  Other users can be registered after start and stop  SCADA Server runtime.

How to proceed:
1. Start browser – it can be done from START menu – SAEAUT SCADA -> SCADA Web Client
or it will be done automatically at the end of installation if you let this option checked in.
2. Register an administrator in SCADA Web Client.
3. Log in to SCADA Web Client
4. Click in main menu on Live Data – after a few seconds SCADA server should be started.
5. Log out from SCADA Web Client
6. Other users (up to the nr. of bought licenses can be registered for access over SCADA Web
Client)

Remark:
In case that you are accessing to SCADA server over Internet/intranet (not from a computer in the
same domain where resides SCADA Server) you need to be registered  in Windows domain first to be
able register and log in.

4 First steps

After installation, the SAEAUT SCADA™  is either started automatically or can be started from START
MENU.
Start of the SAEAUT SCADA™    means opening of introduction view of the
SAEAUT SCADA Web Client application  in a default web  browser. To proceed to functional views,
it is necessary to register user(s)  first.

The first registered user is automatically logged in. He/she can start SCADA Server by choosing
Live Data  in menu of the  SAEAUT SCADA Web Client application.

SAEAUT SCADA™   is delivered with 2 demo configurations that can define its demo functionality .
In case that you have chosen installing DDE client , the easy configuration SystemToExcel.ODG is
activated and so SCADA  Server will run according to this configuration.  If you have not chosen
installing DDE client, a more comprehensive configuration ExampleConfiguration.ODG   will be

32
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activated.  Of course, you can  chose which configuration has to be  activated using SCADA
Configurator  from START menu any time. You can create also own configurations.

We suggest to start with ExampleConfiguration.ODG   and try to understand how it runs
(SystemToExcel.ODG  would not enable to test database fuctionaliy in the web client). This is good
starting point for creation of own configurations.

4.1 Demo configuration

The demo configuration ExampleConfiguration.ODG  enables learning and testing of following
features:

1. Communication of the SCADA Server with external devices that

use external OPC servers as communication drivers

2. Communication of the SCADA Server with external application using enhancing DLL's

3. Communication of the SCADA Server with  databases
4.  Mapping of data items from devices, external applications and cells from database tables to

memory operands

5. Working with alarms - defining of memory operands alarm activation   and alarm
acknowledgment

6. Mapping of memory operands to OPC items of the internal OPC server 

7. Using of function blocks  to perform operations with memory operands

8. Using triggers  to initialize events

9. Defining of events  to call function blocks and start external programmes

10. Working with trends

To understand the example and to be able to create own configurations, it is necessary to learn basic
principles of working with SAEAUT SCADA Server (OpcDbGateway) described in

Integration of applications effectively. OpcDbGateway – configuring and programming, overview.
Details to the working with OpcDbGateway can be found in the on line help of the OpcDbGateway.

The demo configurations SystemToExcel.ODG and DDETestBook enables learning and testing of
connecting  external devices and applications to the SCADA Server using DDE client enhancement.

Details please see in the DDE client on line help.

To watch functionality of the SCADA Server running with the configuration ExampleConfiguration.ODG
you can use the SCADA Web Client. Pictures used for describing of the

work wih the SCADA Web Client  are matching the mentioned configuration. You can also use
internal OPC client built in configurator for reading and writing OPC items to that memomory
operands are mapped.

To start , please open SCADA Configurator from START Menu and chose ExampleConfiguration.ODG
using File->Open from main application menu.
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4.1.1 Using external OPC servers as communication drivers

By installation of the SAEAUT SCADA™  OPC server SAEAutomation OPCSimDA is installed as well.
It is supposed to be used only for demo and testing purposes. SAEAutomation OPCSimDA is used to
simulate connection to an external device over OPC server. It offers changing data items on the
simulated device as well as possibility to write to those data items.

Within Configurator, you can see configured connection to the simulation OPC server in the tree view
under External OPC Servers. There are configured connections to the same SAEAutomation
OPCSimDA OPC server - OPCSimDA and OPCSimDA2.  You can try to configure also your own
connection to this server. In runtime, connection to this sever is provided by internal OPC client built
into SCADA server (see in Figure).

By configuring of connection to external OPC servers you can browse for available servers or write
OPC server id directly. External OPC Servers can be placed on local host or whatever computer in
workgroup or network domain.

As next step you can create OPC groups see e.g.  the group OPCSimDA->Increment that can have
defined e.g. way of communication with OPC server synchronous/asynchronous update rate...

For every OPC group you can choose OPC items by browsing of address space of the external OPC
and provide automatic mapping to memory operands  and to OPC items of
the internal OPC server .
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4.1.2 Using enhancing DLL's

Enhancing Dll's enable to enhance functionality of the SAEAUT SCADA with own programmed
modules that can be used to implement own functionality, to encapsulate ActiveX and dll's from
devices vendors to communicate with their devices and even to implement almost all project
functionality using programming instead of  pure configuring possibilities provided by SAEAUT SCADA
configurator.

There is example with source codes – Exampel1.dll of very easy functionality implemented within
projects for Visual Studio 2005 or 2012 that you can open from Start menu. They can be used as
templates for your own projects. (Figure 1.)

Within configuration, the dll calling must be provided from a function  block. The Example1.dll is called
from the function block Main (Figure 2)

After creating your own enhancing dll,  it is necessary to copy it to the directory where SAEAUT
SCADA is installed - e.g. C:\Program Files\SAEAUT SCADA\ExternalDll.
Calling of the dll must be configured in your configuration

Figure 1: Access to the projects for MS Visual Studio 2005 and 2012 from Start menu
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Figure 2. Configuration of Example1.dll - it is called from the function block Main

4.1.3 Communication with  databases

SAEAUT SCADA™  can connect to many different databases using configured connection strings.
When new configuration is created, default database with the name ProcesDB containing tables
AlarmStatus and AlarmStatusHistory is created automatically. Within the demo configuration, also
connection to another database on the local host – DatabaseExample with tables Employees and
TrendTable is created.

Using configurator, you will be able to configure access to other databases on local or remote hosts, to
create new tables on connected databases or map tables existing on connected databases to the
configuration. You can also define queries for connected databases and  use them in  configuration
e.g. using events.
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4.1.4 Mapping to memory operands

The memory operands area is the place where an information exchange between different external
devices, databases  and computation modules implemented as enhancing DLL's  is executed. By
using of the SAEAUT SCADA™  configurable functionality , we work with memory operands and
provide processing and data exchange between external devices, databases, program modules and
the computing machine of the SAEAUT SCADA™  itself.

16 15
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4.1.5 Internal OPC server

There is an OPC server providing access to memory operands within SAEAUT SCADA™  runtime.
This OPC server is used by SAEAUT SCADA Web Client  and can be used by other OPC DA client
applications as well.

There is possibility to define OPC items within Address space of the internal OPC server and chose to
which memory operands they have to be mapped. Creating of OPC items can be done also
automatically within configurator.  E.g. by configuring of the access to external OPC servers it is
possible to choose that related memory operands and OPC items of the internal OPC server will be
created automatically.

Address space of the internal OPC server can be structured by folders. It enables to estimate which
folders from memory operands configuration contain related OPC items.
E.g. memory operands from folder OPCSimDA_Increment are mapped to the folder OPCSimDA -
>Increment. The same structuring of the address space is used also in the view Live Data  within
SAEAUT SCADA Web Client.

31
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On the level of internal OPC server, different value manipulations can be defined. E. g. OPC item can
be simulated using simulation signals defined in the related folder or converted using one of
conversions. To the OPC items alarms  according to OPC AE specification can be defined. (These are
different than alarms defined for memory operands.)

There is folder with the name System in the address space that is created automatically by default in
every new configuration.  Using variables from this folder, it is possible to monitor or control internal
functionality of the  runtime.  (Memory operands to these variables are not explicitly created, but if
you need a memory operand you can create it. )
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4.1.6 Commands, function blocks

Data processing in SAEAUT SCADA™  - basics

Data processing in SAEAUT SCADA™  is:

· implicit  that does not need configuring or programming, (e.g. transfer of unchanged data from
mapped external OPC servers to internal OPC server.)

· explicit - executed by commands that are organised in function blocks (FB) and enabling
processing of data from external devices applications and databases in SAEAUT SCADA™  runtime
application.

Data processing can be configured using configurable commands (see in  OpcDbGateway User's
Guide->Sync Controller->Function blocks->Commands ) or programmed within enhancing DLL's .

There are default function blocks that are created in every new configuration - MAIN, START,
RESTART, STOP, Write Universal Log Message. (Some of them can be let dummy – without
commands).

There are function blocks that are executed always only one time – by start (FB: START,
RESTART) or stop (FB: STOP) of the SAEAUT SCADA runtime application. There is also FB MAIN
(Figure 1.) that is executed in every cycle of the SAEAUT SCADA synchronous controller. Function
blocks  can be called from another FB using commands CALL or CALLREV.  All FB called from FB
MAIN are called cyclically (because of cyclic implicit functionality of the FB MAIN).

There can be also FBs that are executed as events activated by a trigger .  Within demo application
following FBs are called this way:  Copy actual increment values,   Write Universal Log Message.

Functionality programmed within enhancing dll  is called using command CALLDLL that can be
called from any FB. (In the demo configuration it is called from the FB MAIN).

15
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Figure 1: Function blocks and commands in demo application

FB hierarchy in demo configuration

There is following hierarchy of the FB calls within demo application:

FB: Start
FB: Init

Commands: 1-8
FB: Call Init Alarm Example

Stop
Nothing

Restart
FB: Init

Main
FB: Generate random values
Command: Test arithmetics
FB: Call DatabaseExample_[Employees]_Copy_DB_To_MO
Command: Copy manager salary
Command: Call DLL Example

Function blocks called as events :
Copy actual increment values
Write Universal Log Message

Functionalities demonstrated by FBs in the demo
application

Init – initialization of memory operands by start and restart and calling FB Call Init Alarm Example to
initialise memory operands used by alarming example.

Generate random values – generates random values for memory operands RND/Random1 – 4.

MAIN - command Test arithmetic: makes sum of values of memory operands Test athmetics/Input 1
and Input 2 and put result  to memory operand Test athmetics/Output. As operands Input1 and 2 are
writeable, this functionality can be tested using OPC or web client.

MAIN –Call DatabaseExample_[Employees]_Copy_DB_To_MO – values of records in database
Emplyees are copied to memory operands and can be read over associated OPC items of the  internal
OPC server. There is one MO with special meaning
DatabaseExample_[Employees]_Columns/_RowIndex. This MO is automatically (or per hand ) created
by mapping of database columns to DB operands and related MO operands. It is used to define row in
database table from that are values copied to related MO's. Function block Call
DatabaseExample_[Employees]_Copy_DB_To_MO together with
DatabaseExample_[Employees]_Copy_MO_To_DB have been created automatically using wizard
called  from main menu in configurator – Tools->Wizards->CreateMapping to database table. The
wizard created automatically also database operands, memory operands and OPC items related to
columns of the table.

MAIN – command Copy manager salary is used to show the possibility of reading one cell from
database table using related DB operand - Manager salary to memory operand Manager salary. DB
operands can be created by software wizard for mapping of database tables to configuration.

MAIN – command Call DLL Example –provides cyclic calling of the functionality programmed within
enhancing dll – Example1.dll. It is used to show how programmed and configured functionality can

24
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cooperate.

4.1.7 Triggers and events

Events in SAEAUT SCADA™  are initialised by triggers. Events can provide:

· Executing of function blocks,
· call an external program
· provide functionality related to configured logging
· provide activities related to configured reporting or different queries on databases
· easy testing functionality (beep).

Events can run as synchronous – running in the same program thread as FB MAIN, or
asynchronous – running in distinct asynchronous thread.

Triggers used to initialise events can be of following types:

· based on value of a memory operand – trigger is activated when configured MO has value TRUE,
· based on time -  trigger is activated when defined time elapsed.

Triggers based on time can be periodic or one time valid. Periods of triggers can be either related to
start of the synchronous controller (strict period keeping) or related to calendar – period need not be
always the same – e.g. according to nr. of days in a month.

Triggers based on memory operands can provide reset of the memory operand after one period of the
synchronous controller (related event will be activated only one time),  or can be set all the time till
reset from outside (related event will be activated in every period of the synchronous controller).

Figure 1. Configuring of event to start external application – default web browser.
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Within demo following events are used:

Copy actual increment values  - is used to show how to configure copying of data values from one
external OPC server to other. It provides calling of FB with the same name in asynchronous thread
when trigger - 10s Period trigger is initiated -periodically every 10 s. Within this FB ,values from
external OPC server SimDA - group Increment are written to external OPC server SimDA2  group
Increment_write using memory operands to that related OPC items are mapped.

Run Browser with first page - is used to show how to start external application from SAEAUT
SCADA. The external application is started 5 s after start of the SAEAUT SCADA runtime by trigger
Run Browser after 5s. Using application cmd.exe with  file name with extension html as parameter, it
is provided that the file will be opened  in default web browser.

Run IExplorer - it provides start of the external application MS Internet Explorer when trigger of the
type value is activated. It is alike functionality as by previous event, but at this time can be activated
also from outside using memory operand Triggers/IExplorer and OPC item with the same name.

TrendsTable_Event - it is used to activate periodic writing to the trend

Universal Log Event - it is used to provide writing a message to log file. It is activated by memory
operand, that can be set e.g. from enhancing dll. This way can enhancing dll use logging functionality
of the runtime application.

4.1.8 Alarms

The source of alarm in the proprietary alarm system of SAEAUT SCADA is memory operand (MO).
There are 2 MO within demo application:

Alarm Handling Example/Alarm Input - this memory operand is mapped to OPC item and so
changing its value from outside, it is possible to experiment with alarming in the demo configuration.
Alarm definition Memory Operand Alarm Example that is associated to this MO contains also definition
of the memory operand Alarm Handling Example/ AlarmAck that is used to confirm (acknowledge)
activated alarm from outside.

DLLExampleData/Dll Example Return - this memory operand has associated alarm definition DLL

24
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Call Unsuccessful. This alarm is not supposed to be acknowledged and so has not associated MO for
that.

Please see more about alarming within this demo  in description of SAEAT SCADA Web Client.

4.1.9 Trends

Trend in SAEAUT SCADA stands for periodic writing of values of a chosen set of memory operands to
a database table.  As to the memory operands data from external devices applications and databases
and even results of the internal computations can be mapped, it is efficient and universal way of
logging structured data from all those sources to database.

This activity can be configured using standard configuration means – triggers, events, SQL queries.
The whole configuring process would be relatively complicated. Because of this, within configurator a
software wizard (started from main mane Tools->Wizards->Create Historic Trends) , that makes
configuration of trends much easier, has been created.  What is provided by the wizard is shown in
Figure 1 where you can see the start view of the wizard.
A summary what has been created by wizard is shown in Figure 2.
After running the runtime you can see in configurator values of the trend written to the table created by
wizard (see Figure 3).

Figure 1. Start view of the Historic Trends Wizard
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Figure 2. Overview of the configuration of the historic trend with the name "TrendsTable".

Figure 3. Results of the trend configuring.

4.1.10 Demo summary

Demo configuration (and whatever other configuration of the SAEAUT SCADA™ ) has following parts
(Figure 1):
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· configuring of external data sources - external dll's - External DLL Example, external OPC servers -
OPCSimDA and OPCSIMDA2, process databases - ProcessDB and DatabaseExample

· configuring of data processing - all items under Sync Controller
· configuring of connection to client applications as SAEAUT Web Client  - over Internal OPC

Server
· configuring of higher level functionality as Alarm handling for memory operands and Trends

31
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Figure 1 Main parts of the SAEAUT SCADA™  configuration

Control flow by data processing

By configuring, the control flow picture (Figure 2) is created automatically (It can be displayed using
main menu of the configurator View->Graphic project viewer).  Triggers, events, function blocks are
displayed as rectangles within the control flow.  By click on the rectangle, it is possible to get fast to the
related entity and edit its settings.

There are 2 parallel lines representing functionality executed cyclically (PLC cycle) during period of the
synchronous controller in synchronous thread. There is only function block MAIN executed within
synchronous thread in the demo application (FB called from FB MAIN are not shown in the control flow
picture).   In case that we want also another function blocks to be executed within synchronous thread
(repeatedly or not) they can be called as synchronous events.

There are shown asynchronous events that run in different - asynchronous thread.  In the control flow
we can see that they are not displayed between horizontal lines of the synchronous cycle. Every from
them is started by a trigger and provides executing of an internal activity – call FB, execute query on a
database external activity (not represented by rectangle)  or external activity – call an external
program.  There

We can see also on time executed FBs  (START, RESTART and STOP) in the control flow picture.
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Figure 2 Graphic project viewer.

Conclusion

Demo application does not cover all aspects and possibilities offered by the SAEAUT SCADA™ . For
example, as SCADA systems works often with big amounts of data points on external data sources it is
necessary to understand the possibilities of mapping those data points to configuration. All details to
that please see in online help of the product OpcDbGateway.

4.2 Your own first configuration

To create your first configuration (project) you need do very little. Open SAEAUT SCADA™
Configurator from Start menu and chose from main menu File->New,  write the name of your
configuration in the file dialog box and confirm with Save.  After that, your first application is created
and checked. Very probably, the result of the checking, that will be shown in the Checker View in
configurator, will be „0 error(s), 0 warning(s)".  (When you will enhance the configuration, it is useful to
repeat the checking from time to time again using Tools -> Check configuration.  In case that you
made an error, you can click on the line where error is announced and dialog box, where error can be
removed, will be opened.)

Although you have not done very much till now, your first configuration is created and SAEAUT SCADA

http://home.gts.sk/saeautomation/help/opcdbgateway/index.html
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runtime using it can be started. It can be done directly in configurator from menu using View->Monitor
view or by click on Glasses – icon.   This way an OPC client built into the configurator (represented by
Monitor View) will be started and connected to the internal OPC server of the SAEAUT SCADA™ .
(Another possibility to start runtime is to open SCADA Web Client in browser and chose menu item
Live Data .)

Notwithstanding that you have configured none data points (OPC items of the internal OPC server) till
now, there are some created by default for every new configuration.  These data points enable to read
and in some cases also to  write to variables accessing   the internal functionality of the SAEAUT
SCADA™  Runtime.  Please go to the tree view and chose Internal OPC Server->Address space-
>System->Status. In the monitor View, you will see all OPC items from the folder Status. (To see
values from other folders, you can click on a folder in tree view). There is e.g item
SystemStatus.LocalTime with continually changing value.

Description of other system variables can be fond in OpcDbGateway User's Guide->System variables.

Important: To be able to continue in enhancing of your first application, SAEAUT SCADA™
runtime must be stopped first!

As the next step we try to connect an external device  to the  SAEAUT SCADA™ .

33
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4.2.1 Connecting external devices

Main purpose of the SCADA systems is communicating with external devices. To do it, we can use
communication drivers implemented as own enhancing dll's or as external OPC servers.

Using of external OPC servers is preferred, for this way we can use configuration wizards built in the
configurator. Another advantage is that we do not need explicitly configure data flows from external
OPC servers trough internal OPC server  to the SCADA Web client. All this is configured automatically.
Details please see in OpcDbGateway User's Guide-> Configuring and programming-> External OPC
servers.

To try it, we can use simulation OPC server as mentioned also in description of the
demo configuration .
After configuring using mentioned wizards, we do not see in the configuration any function blocks
created for that.  However, because OPC items from external OPC servers can be automatically
mapped to memory operands that can be seen in configuration, we can make different operations with
them using configured commands. For results of the operations, we can configure own memory
operands and every such operand can be also easily mapped to OPC item of the internal OPC server.
The way how to do it please see in OpcDbGateway User's Guide-> Configuring and programming-
>Sync Controller->Memory operands.

In case that you communicate with external devices using enhancing dll's , it is not possible
foreseen the functionality (for very universal approach) and so memory operands for communication
with  enhancing dll's have to be configured one by one.  Details can be found in OpcDbGateway User's
Guide->External Dll usage.

4.2.2 Saving data to databases

Data from external sources or gained as product of computation in SAEAUT SCADA™  runtime can be
saved to different databases. It can be MS SQL Server, MySQL Oracle, MS Access or whatever
relational database to that we have installed database driver. You can  add database placed on

local or remote host to the configuration as described in OpcDbGateway User's Guide->Process
Databases.

To create connection string to database you can use connection string wizard described in
OpcDbGateway User's Guide->Process Databases->Connection wizard.

To work with databases we can use either special set of configurable database commands or SQL
queries. The advantage of queries is that individual features of different databases can be better taken
into account.

For a small applications we can use MS Access database ProcessDb.mdb that is installed in the folder
x:\Users\xxx\Documents\SAEAUT SCADA\Data\. This database is automatically configured for every
new configuration that you create.  If you do not need it, it can be removed from configuration.
However, this database contains preconfigured tables for working with proprietary alarm system and
so, if you want to use it, it is necessary to create table with the same structure in another database that
you want to use.

There are two possibilities to configure usage of databases in your configuration:

1. To create database tables on the connected database and then to map them to the configuration.
Details see please in OpcDbGateway User's Guide->Process Databases->Database table
mapping wizard,

2. to connect to the database and to map it to the configuration of the SAEAUT SCADA as described
in OpcDbGateway User's Guide->Process Databases->Create table in configuration.

13
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Within configuration, fields and columns of the database tables are represented as database operands
– see please in OpcDbGateway User's Guide->Sync Controller->DB Operands. DB operands can be
used as arguments in configurable commands for working with databases. See please in
OpcDbGateway User's Guide->Sync Controller->Function blocks->Commands->Database operations.

In case that you will work with queries only, it is not necessary to create DB operands,

The periodical saving of variables to database is the most typical database functionality in SCADA.
After mapping of data points from external devices and applications to memory operands and
configuring of connections to process databases, it is possible to configure this functionality very easy
using historic trend wizard  described in   OpcDbGateway User's Guide->Historic Trends Wizard.
It is very useful to study results of the historic trend wizard activity to understand using of events
queries and triggers for working with process databases. You can also modify it a little and this way
implement different scenarios without complex configuring database activity from scratch,

Sometimes it can be useful for you, instead of writing raw values of memory operands to database, to
write them within an explanation text. For that purpose user messages described in   OpcDbGateway
User's Guide->Sync Controller->Function blocks->Commands->User Messages operations are used.

5 How to work with SAEAUT Web Client

In this chapter you can find:

· how to register new users of the SAEAUT SCADA Web Client.
· how to log in
· how to watch end edit live data on SAEAUT SCADA server
· how to watch data saved in process databases and create interactively reports defined by SQL

queries
· how to watch status and history of alarm sources and how to acknowledge and comment activated

dynamic alarm.

5.1 Security

Access to the SAEAUT SCADA™ system is secured by two-level authentication:

1. User registration into the SAEAUT SCADA™   via form and then sign in with the name / password.
If the user is not logged on, he does not have access to functional sites and can not even see links
to functional sites.

2. Windows authentication, which is required for access to functional sites. To enable the user to
access a given page, he / she must specify the domain name / password , which are recognized
by the domain server on that  SAEAUT SCADA™  is running. Possible authentication providers
are NTLM, Negotiate, Kerberos.  It can be set in IIS manager.  If the user is using a browser that
automatically sends his credentials  in header  (e.g. IE, Chrome), he does not need repeat sending
of name / password and can automatically access the page. All the functionality that a user
performs on functional sites is done under the Windows identity that entered.

How it works in practice:

The user logged on to the domain enters the username / password that was used for the registration
into the  SAEAUT SCADA™ . This gives automatic access to SAEAUT SCADA™  functional sites.

The user who is not logged on to the domain is asked  to enter also the Windows domain name and
password to access the functional sites of the SAEAUT SCADA™ .

24
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Remark: In case the browser on a mobile device does not support NTLM or Kerberos authentication,
you must configure basic authentication using IIS Manager.

5.1.1 Registration

Before registration none access to data from SAEAUT SCADA™  server is allowed. Also administrator
of the server on that SAEAUT SCADA is installed must be registered.

Registration for a user can be done either by administrator of the computer or by user himself.
Administrator can restrict possibility to register for SAEAUT SCADA Web Client usage for some
domain users in MS IIS administration console. He can also disable possibility to register by users at
all. Disabling of self registration by users can be provided by setting of application variable
AllowRegisterNewUser in IIS Manager to „False",

Figure 1 Registration dialog box.

After succesfull registration, login to the web application is done immediatelly.
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5.1.2 Database access

There can be two or three level authentication:
· on the level of SCADA web client – it is applied always
· Windows authentication  - it is applied always because only user registered in Windows domain of

the SCADA server  has access to web client functional pages (including page to access to
databases)

· Name/password pair that can be set individually in web client for every process database

Figure 1. Using special name / password pair to access chosen process database.

5.2 Log in

Registered user can login after launch of the application in web browser. Maximal nr. of logged in users
is limited by nr. of purchased licenses.

Figure 1: Some menu items are not shown before logging in.

5.3 Live Data

Current data from the SAEAUT SCADA server are displayed in a tree structure as defined by the
configurator (Figure 1.). It enables efficient structuring of data for visualisation by configuring. The
content of each directory of the tree is displayed as the table (Figure 2). In addition to the variables
values displaying, the information on data quality and timestamps are shown as well. Data of the type
read/write can be edited in web client (Figure 3).
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Figure 1: Tree structure of the data configured in SAEAUT SCADA (OpcDbGateway) configurator.
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Figure 2: Tree view and data table of the live data in SAEAUT SCADA Web Client
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Figure 3: Writing to live data item.

5.4 Data from Databases

The view enables creating of queries to all the tables from databases that are defined in the
configuration of SAEAUT SCADA™ .

Figure 1. Showing of the table Employees from the database DatabaseExample.

Creating queries
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After loading the page, loading of defined databases that are stored in the first combo box will be
started. After selecting the database from the first combo box reading the information about the tables
in the database, which are stored in the second combo box will begin. After choosing table from the
chosen database in the second combo box, the SELECT that contains all the columns of that table will
be automatically created. It can be freely adjusted by user and saved to the history of the created
selects. After pressing the Query button the query result is placed in the grid. To delete query saved to
history delete all text in the query edit box and confirm.

Changing access rights to the database

To change the access rights to the database defined in the configuration of SAEAUT SCADA, click on
"Database connection settings (Show details ...)". You can use the username / password to access the
database\ or Windows authentication (it is chosen by default using check box displayied if you click
Show details).

Sorting of the table

Results in the grid can be sorted by every column by clicking on the text in the column header. For
descending sorting, it is necessary to click on sorted column again.

Faster processing

For faster processing, we recommend to limit the size of the resulting table. It can be achieved eg. by
adjusting query this way: "SELECT TOP 100 * FROM Table".  Then only the first 100 records of the
large table will be displayed.

Paging of the big table

You can move through the table that is automatically paged in case that all records can not be shown
in one page. To choose page, click on the page number at the bottom of the table.

Table refresh
The information in the table is refreshed regularly as set using the edit box below the table.
.

Exporting of query results

Result of query can be exported into formats excel, word, pdf and  csv. For the csv format delimiters of
the items can be chosen and for the pdf format size of the page can be set. After chosing the file
format, the report is dpwnloaded to the user's computer.
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Figure 2. Showing the paged table and choosing of pdf report page size.

5.5 Alarms

Proprietary alarm system in SAEAUT SCADA™

SAEAUT SCADA™  allows to visualize the current state of alarm sources, which SAEAUT SCADA
server writes to process database. It also lets you view the statuses history of alarm sources.

The source of alarm in the proprietary alarm system of SAEAUT SCADA™  is memory operand (MO).
Variables (data points) of variety external data sources such as OPC servers, other communication
drivers of different devices and cells of database tables can be mapped to MO's in SAEAUT SCADA™
. MO can contain results of various logical operations (functions) with variables saved in other MO's.
Because of this, alarm generated by SAEAUT SCADA™  can depend on evaluation of different easy or
complex conditions in external devices or connected software applications.

Whether MO is to be a source of alarm or not is defined by its configuring. MO to become a source of
alarm, it must be assigned a preconfigured definition of alarm processing. If the definition is not
assigned, then the MO cannot be the source of an alarm.

Static and dynamic alarming

Static alarming differs from dynamic that it does not / does validate (acknowledge) status of the alarm
state by human operators. The acknowledgment source is again MO in SAEAUT SCADA™ .
Therefore, similar to the alarm source, it can be the result of evaluating of a complex operation
executed using several MO's.

States and transitions between states of alarms

For static alarming, each alarm source has 2 states:
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· Activated (come)  ...
· Inactivated (not active or gone)

It is due to the fact that the alarm is characterized only by a single variable - alarm source. In the
dynamic alarming, the alarm entity is defined by two Boolean variables (MO's) - alarm source and
acknowledgment source representing a total of four possible states:

· Not active
· Activated  (Come)
· Inactivated ( Gone)
· Acknowledged

The alarms entities are visible in the alarm status table in the SAEAUT SCADA™  with a constant
number of rows equal to the number of configured alarm sources. Transitions between states are
recorded as events in the table of alarm history. Here is recorded when there was a transition from one
alarm state to another as well as one of two possible configurable messages:

· Message when the value of the alarm source is changed from false to true,
· Message when alarm source value changes from true to false.

As mentioned above, the source of the alarm is MO. The alarm source has a definition of alarm
processing which includes:

· Alarming type - static / dynamic ,
· Alarm messages (in several languages) to be entered in the alarm history table at birth and at

death alarm conditions,
· Whether the alarm is permitted to return from active to inactive status,
· Source acknowledgment alarm (MO) - must be configured in advance,
· Whether on alarm activation should be sent to SMS and / or e-mail.

Related links on the web
  OpcDbGateway on line help

Alarms in OpcDbGateway
OpcDbGateway on the web
OpcDbGateway blog

Related articles
Configuring of Alarms 

Alarm Status Table

Alarm History Table
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5.5.1 Configuring of Alarms

Alarms are configured using SAEAUT SCADA (OpcDbGateway) configurator.

Configuring of memory operands as alarm /
acknowledgment source

There has to be configured memory operand that is used as source of alarm (Figure 1) and , in case
that we want to create dynamic alarm (that requires acknowledgement), also the memory operand
used as source of acknowledgement.
Every alarm source has to have defined way of alarm processing. Alarm processing definition (Figure
2) can have configured messages that are written by activation an deactivation of alarm. Dynamic
Alarm processing definition has to have defined  memory operand used as source of
acknowledgement.
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Figure 1. Configuring that memory operand  "AlarmInput" has to be used as alarm source with the
alarm processing definition "MemoryOperandfAlarmExample".

Configuring of alarm processing definition
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Figure 2. Configuring of alarm processing definition  "MemoryOperandfAlarmExample" that provides
writing of message '"TestAlarmMessage-Active"    to the alarm history by activation of alarm.  The
message contains parameters - memory operands Alarm Input and Alarm Ack. Because of this, their
values actual by writing of message will be written as well.

5.5.2 Alarm Status Table

Visualising of alarms statuses configured as described in “Configuring of Alarms” .

Figure 1: Alarm status table with 2 alarm sources. The first one is in status "Not active", the second in
status Activated  (Come)

Columns in the alarm status table (Figure 1) have following meaning:

ID
Alarm identifier generated by SAEAUT SCADA server. It can be used in live data item

'System.Alarms.ActualAlarmIndex ".

Group
Group defined by the alarm configuring – can be used for filtering of alarms in

SAEAUT SCADA™ .

Source
Path to the memory operand, which activates the alarm.

Status
Status of the alarm (NOT ACTIVE, COME, GONE, Acknowledged)

Time
Time of last change of alarm status

Message
The messages that can be configured to be written when alarm is activated or

deactivated

Comment
Comment entered by user upon confirmation of alarm.

Columns Group,  Source and Status can be used for filtering of alarm sources that has to be shown in
the table. Ack  is shown only by dynamic alarms that require acknowledgment.
Data in table can be sorted according every column upwardly/in descending order.

40
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Figure 2: When acknowledging alarm comment which can be written to alarm history can be added.
(To be written also Ack button is to be pushed )

Figure 3: Alarm status table with 2 alarm sources. The first one is  in status "Not active", the second in
status ACKNOWLEDGED.

Figure 4: Alarm status table - Alarm source ID = 2 was  deactivated without being acknowledged and
so it is in status GONE now.

5.5.3 Alarm History Table

Alarms History table contains log of every alarm status change for every alarm source. Meaning of
table columns is the same as in Alarm Status table ..42
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6 Documents downloads and white Papers

OpcDbGateway - on line help
OpcDbGateway on the web
OpcDbGateway blog
Buy on line
On line help
OpcDbGateway - documents, videos, white papers and downloads
SAEAUT UNIVERSAL OPC Server - documents, videos, white papers and downloads
DDE client for OpcDbGateway and SAEAUT UNIVERSAL OPC Server 

http://www.sae-automation.dtadsl.sk/products/opcgway/onlinehelp/index.html
http://www.saeautom.sk/products/opcdbgateway.htm
http://opcdbgateway.wordpress.com/
http://www.saeautom.sk/en/products/order.htm
http://www.sae-automation.dtadsl.sk/products/opcgway/onlinehelp/index.html
http://www.saeautom.sk/en/products/opcdbgateway/download.htm
http://www.saeautom.sk/en/products/uniopcserver/download.htm
http://www.saeautom.sk/en/products/ddeclient/
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